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Introduction To Accounting
 It is beyond the scope of this help file to explain accounting principles, Therefore it is highly recommended

that you have some experience in accounting before using the program package. But as a reminder just remember 
that double entry accounting is nothing but a reflection of the basic equation that:

                            ASSETS = LIABILITIES + EQUITY

Assets are Thing that you own if you owe on them or not. An example of Assets would be: Automobiles,
Office Equipment, Cash Accounts, fixtures, etc.. Liabilities is the money you owe, an example of this would be: 
Accounts payable, state tax payable , and notes payable. Equity is the money or equipment that you originally 
invest in the business or entity. 

Anything that increases your assets increases your equity and vice versa. Anything that increases your 
liabilities    decreases your equity.    Assets are placed on the debit side of the ledger and liabilities and equity are 
placed on the credit side of the    ledger, so credits equal debits. 

Income and expense accounts are eventually reflected in your equity accounts but they are not posted 
directly to your Net Worth or Accumulated Earnings accounts until the end of your accounting year.

 When you deposit a check consisting of income two things happen.    Your bank account increases, so it is 
debited, and one of your income accounts increases,(which eventually increases equity) so it is credited.

When you write a check for an expense item two things happen. Your bank account decreases, so it is 
credited, and one of your expense accounts (which eventually reduces equity) increases, so it is debited.

Accounting Situations
Sample Chart of Accounts



Overview of Visual Accounting System
Visual Accounting System for Windows is an application that uses linked Spreadsheets and Databases that are 
packed full of accounting tools for business large or small. Reports, Ledgers, or Compound Transactions for any 
given date can be displayed on the screen. You can use the Sample books that are provided or you can start from 
scratch and virtually build your own accounting program. VAS will allow you to design you own printouts using a 
system similar to Dbase's report design screen. Features Include:

* User Configurable Printouts for Each Account. Similar to Crystal Reports
* Create Any Account that you Desire
* A Very Large Context Sensitive Help File To Get You Started
* Empty Set Of Books ready to Use
* A Set Of Books With Sample Transactions 
* Security System that can provide limited access certain users for each
    set of books.
* Up to 64K of notes For Each Account
* Setup Sales Tax For Each Account
* Programmable Calculations In Compound Entries for Each Accounts
* 2 Billion Transactions Per Account In Registered Version      
* 32 Thousands Entries In each Report Screens 
* 100 Reports In Each Set Of Books
* Unlimited Sets of Books
* Add Numbers Between Reports
* Supports Wide Carriage and Landscape Printouts
* Easily Expandable by Inserting New Accounts Whenever Needed
* Supports Compound Entries For Any Account
* Allows Reconciled Transactions
* Account Reference Window, So You Don't have To Remember Account
    Numbers.
* Allows Any Type of Accounting.
* Change and Delete Accounts as you Wish.
* Converts Numbers to Words For Easy Check Printing
* Audit Trail for Each account that records deleted transactions
* History Window for Each Account that allows an overview of all dates
* Account Hot Keys
* View Between Any Date in the Ledgers
* Supports Color Printers
* Negative numbers are displayed in Red

Note: VAS can be used as a standalone Accounting system or can be used 
with custom programmed modules that can be developed to you needs.
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Visual Accounting System Version 3.0 For Windows.
Name:______________________________________________

Address:_____________________________________________

City: __________________________________________________

State: ____________                  ZIP: _____________________________

For Only $50.00 US Dollars You Will Receive The Complete Working Registered 
Version of Visual Accounting System For Windows In The Mail. The Complete 
Version Will Allow you To have an unlimited amount of Transactions for each 
account. You will also receive Demos of any modules that are released for VAS.
-------------------------------------------------------------------------------------------
    Disk format:                                                          3.5"                                                                                                 
5.25"
-------------------------------------------------------------------------------------------
Please Make Any Helpful Suggestions or any special instructions Here. 
I May Include any changes or Add-ons that you Suggest in your Registered 
version of Visual Accounting System.
-------------------------------------------------------------------------------------------
Suggestions:______________________________________________________

_________________________________________________________________

_________________________________________________________________

_________________________________________________________________

_________________________________________________________________

_________________________________________________________________

_________________________________________________________________
=======================================================
==========

Signature:________________________________________________________

Send make your check or money order out to:
        Dragon Software
        P.O. Box 299
        Lumberport, WV    26386

                                                    Thank you for registering Visual Accounting System



Definition of Shareware
Shareware distribution gives users a chance to try software before buying it. If you try a Shareware program and 
continue using it, you are required to register it (or purchase the licensed version as in the case of Dragon 
Software's Visual Accounting System). Copyright laws apply to both Shareware and retail software, and the 
copyright holder retains all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like retail authors, and the programs are of comparable quality. (In both cases, 
there are good programs and bad ones!) The main difference is in the method of distribution. The author specifically
grants the right to copy and distribute the software, either to all or to a specific group. For example,some authors 
require written permission before a commercial disk vendor may copy their Shareware.
Shareware is a distribution method, not a type of software. You should find software that suits your needs and 
pocketbook, whether it's retail or Shareware. The Shareware system makes fitting your needs easier, because you 
can try before you buy. And because the overhead is lower, prices are lower also. Shareware has the ultimate 
money-back guarantee -- if you don't use the product, you don't pay for it.



This entire program and help file was written by K.S. Cupp of Dragon Software, However I 
must give special thanks to the current Registered users
and Beta Testers, without them, you would not be reading this.



Demo Restraints
This demo version limits the number of transactions to 100 that can be view in each account's ledger, But Still 
Stores them on the Hard Disk. Installing the Registered Version Correctly will allow you to View the ledger entries 
past 100. 

VAS and the accompanying files may not be sold or included as a part of another product (even if for "free").    A 
nominal charge for distribution    media may be made. You are encouraged to give copies to your friends or to post 
the program on a BBS, provided that you do not make any changes to any of the files. You Are also encouraged to 
make samples books if you wish and allow other users to try them out.



LIMITED WARRANTY AND DISCLAIMER OF WARRANTY 
THIS SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING INSTRUCTIONS FOR USE) ARE 
PROVIDES "AS IS" WITHOUT WARRANTY OF ANY KIND. FURTHER, DRAGON SOFTWARE CO.,DOES NOT 
WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF 
USE, OF THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY,
CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE 
SOFTWARE IS ASSUMED BY YOU. IF THE SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE YOU, AND 
NOT DRAGON SOFTWARE CO. OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE 
ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.
 
THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, THAT IS MADE BY DRAGON SOFTWARE, ON THIS DRAGON SOFTWARE CO. PRODUCT. NO ORAL
OR WRITTEN INFORMATION OR ADVICE GIVEN BY DRAGON SOFTWARE CO., ITS DEALERS, 
DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE 
SCOPE OF THIS WARRANTY AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. YOU MAY 
HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE. NEITHER DRAGON SOFTWARE CO. NOR 
ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION,    PRODUCTION OR DELIVERY OF THIS 
PRODUCT SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES 
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH PRODUCT EVEN IF 
DRAGON SOFTWARE CO. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
 

This Limited Warranty shall be governed and construed in accordance with the laws of the 
State of West Virginia. 
    ACKNOWLEDGMENT
BY USING THE SHAREWARE VERSION OF VISUAL ACCOUNTING SYSTEM YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS LIMITED WARRANTY,    UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS' TERMS AND 
CONDITIONS. YOU ALSO AGREE THAT THE LIMITED WARRANTY IS THE COMPLETE AND EXCLUSIVE 
STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND
SUPERSEDE ALL PROPOSALS OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY OTHER 
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER OF THE LIMITED 
WARRANTY.



Accounting Situations
Services for Cash
Services on Account
Payment on Accounts Receivable
Cash Purchase of Equipment
Purchase of Equipment on Account
Employee Payroll
Sales Returns and Allowances
Purchase of Merchandise
Prepaid Insurance
Prepaid Rent
Handling Supplies
Depreciation
Unearned Revenues
For more information about Accounting Situations you should visit your local Library



Sample Chart of Accounts
ASSETS
Note: Assets have A normal Balance Of Debit
100....................................................................................... Cash in Bank
102....................................................................................... Cash-Payroll Account
105....................................................................................... Money Market
107...................................................................................... Petty Cash
110...................................................................................... Accounts Receivable
115...................................................................................... Interest Receivable
116...................................................................................... Due From Employees
117...................................................................................... Allowance For Bad Debts
120 ..................................................................................... Inventory
130...................................................................................... Prepaid Insurance
132...................................................................................... Prepaid Interest
134...................................................................................... Prepaid Taxes & Licenses
136...................................................................................... Prepaid Expenses
150...................................................................................... Furniture & Fixtures
152...................................................................................... Machinery & Equipment
154...................................................................................... Leasehold Improvements
156...................................................................................... Buildings
158...................................................................................... Land
160...................................................................................... Accumulated Depreciation
180...................................................................................... Investments
182...................................................................................... Deposits
Liabilities
Note: Liabilities have a normal Balance of Credit
200...................................................................................... Accounts Payable
210...................................................................................... Notes Payable
215...................................................................................... Layaway Deposits
220...................................................................................... FICA Payable
221...................................................................................... Federal Withholdings Payable
222...................................................................................... State Withholdings Payable
230...................................................................................... Salaries & Wages Payable
240...................................................................................... Sales Tax Payable
Equity
Note: Equity have a normal balance of Debit
300...................................................................................... Paid In Capital
310...................................................................................... Common Stock
399...................................................................................... Retained Earnings
Revenue
Note: Revenue Accounts have a normal Balance of Credit
400...................................................................................... Sales Revenue
405...................................................................................... Service Revenue
410...................................................................................... Sales Discounts
411...................................................................................... Sales Returns/Allowances
420...................................................................................... Finance Charge Revenue
425...................................................................................... Interest Revenue
431...................................................................................... Credit Card Discounts
449...................................................................................... Miscellaneous Revenue
450...................................................................................... Merchandise Purchases
454...................................................................................... Purchase Discounts
456...................................................................................... Purchase Returns/Allowances
458...................................................................................... Freight In
Expenses
Note: Expenses of have normal balance of Debit
500...................................................................................... Salaries and Wages
510...................................................................................... Advertising Expenses
511...................................................................................... Amortization Expenses
513...................................................................................... Auto Expenses



516...................................................................................... Bad Debts
519...................................................................................... Cash Over/Short
521...................................................................................... Commissions Expenses
524...................................................................................... Contract Labor Expenses
527...................................................................................... Charitable Contributions
530...................................................................................... Depreciation
533...................................................................................... Dues and Fees
534...................................................................................... Entertainment

Note: that all Contra Accounts are the opposite of the Normal Balance



Services On Account
Situation:
Your Business Performs a Repair Service on John Ball's Computer For $100.00 and is put on Accounts 
Payable.
Accounting Method:
Debit Accounts Receivable                          $100.00
            Credit Service Revenue                                        $100.00
Vas Method:
To Debit Your Accounts Payable You Would Open The Ledger to the account that you have setup for 
John Ball.    You Would Then Place an Entry In The ledger like This:

To Credit your Service Revenue you would place the Account Number in the Account Field. Remember 
That Service Revenue is a Credit Account and should have a normal Balance of Credit.

See Also
Setting Up New Accounts
NOTE THAT ALL ACCOUNT NUMBERS ARE USED AS EXAMPLES FROM THE SAMPLE CHART OF ACCOUNTS AND MAY NOT 
BE THE ACCOUNT NUMBERS YOU WISH TO USE.



Services For Cash
Situation:
 Your Business Performs a Repair Service on John Ball's Computer for $100.00
Accounting Method:
Debit Cash In Bank                                                        $100.00
            Credit Service Revenue                                            $100.00
Vas Method:
To Debit Your Cash In Bank You Would Open The Ledger of the account that you have specified as your 
CASH IN BANK, Remember that CASH IN BANK is an Asset and should have a normal balance of DEBIT. 
You Would Place an Entry In The ledger like This:

To Credit your Service Revenue you would place the Account Number in the Account Field. Remember 
That Service Revenue is a Credit Account and should have a normal Balance of Credit.
NOTE THAT ALL ACCOUNT NUMBERS ARE USED AS EXAMPLES FROM THE SAMPLE CHART OF ACCOUNTS AND MAY NOT 
BE THE ACCOUNT NUMBERS YOU WISH TO USE.



Payments On Accounts Receivable
Situation: 
John Ball Makes a payment of $500.00 on his Computer he purchased on Account.
Accounting Method:
Debit CASH IN BANK                                                  $500.00
            Credit Accounts Payable                                            $500.00
Vas Method:
To Credit Your Accounts Payable you would Enter the Information to John Ball's Account Ledger like this:

Notice that the amount has been entered as a negative number. Since Accounts Receivable is normally
a Debit account, placing a negative number in the amount field will create a credit. The Balance Field 
will show how much more money he owes you. By placing the account number of CASH IN BANK in the 
account field, CASH IN BANK will automatically be debited for you.
NOTE THAT ALL ACCOUNT NUMBERS ARE USED AS EXAMPLES FROM THE SAMPLE CHART OF ACCOUNTS AND MAY NOT 
BE THE ACCOUNT NUMBERS YOU WISH TO USE.



Cash Purchase of Equipment
Situation:
Your Business buys A Computer Desk To Place The Boss's computer on for $500.00
Accounting Method:
Debit Office Furniture and Fixtures                  $500.00
              Credit Cash in Bank                                                                  $500.00
Vas Method:
To Credit Your Cash In Bank You Would Open The Ledger of the account that you have specified as your
CASH IN BANK, Remember that CASH IN BANK is an Asset and should have a normal balance of DEBIT. 
You Would Place an Entry In The ledger like This:

Notice that the amount has been entered as a negative number. Since CASH IN BANK is normally a 
Debit account, placing a negative number in the amount field will create a credit. The Balance Field will
show how much money you have in the bank. By placing the account number of OFFICE FURNITURE 
AND FIXTURES in the account field, the account will automatically be debited for you. If you have more 
than one thing on an invoice you would need to create a complex transaction.
See Also
Complex Transactions
NOTE THAT ALL ACCOUNT NUMBERS ARE USED AS EXAMPLES FROM THE SAMPLE CHART OF ACCOUNTS AND MAY NOT 
BE THE ACCOUNT NUMBERS YOU WISH TO USE.



Purchase of Equipment on Account
Situation:
Your Business Buys A Computer Desk To Place The Boss's Computer on for $500.00 and you agreed to 
make payments.
Accounting Method:
Debit Office Furniture and Fixtures                  $500.00
              Credit Accounts Payable                                                    $500.00
Vas Method:
This Situation is the same as Purchasing Equipment with case Except you Credit your Accounts Payable
instead of CASH IN BANK

See also
Cash Purchase of Equipment



The Main Window
This is the window you will see when you start VAS. This area is where you define your reports. You give them a 
name and a description. If you start a new set of books, this screen will be empty and ready for you to enter the 
information you want. If you wanted to create a balance sheet report you would    Enter a name for the report and 
Balance sheet for the Description.

Name Field:
This is the field you give your Accounting Report a name. This field can have no more than 8 
characters, no spaces, and no periods. If you change the name of the Report, a new report will appear, 
removing the information stored in the old report, if you make this mistake you can recover the lost 
information by entering the old name back into the name field.

Description Field:
This field can have up to 50 characters, and is where you describe the Report you wish to create. Once 
you have Created a report and started using it, it is not recommended that you delete the report, 
because all the accounts that have been created on that report will be deleted along with it.

Menus:
Other than the typical menu items there is nothing special to describe for the menus. You can delete 
lines, insert lines and etc. Under the File Menu is the option to create a New Set of Books and to Open 
A Set of books. When You Select the menu option CREATE A NEW SET OF BOOKS, Vas will ask you 
where you want to put these books, simply type in the Path where you wish to create these books, if 
that path does not exist, Vas will Create it.

Opening A Set of Books: Vas will Display a Input box, You need to type in the path for the books you 
wish to open, if the path is not valid or there is no Valid books for that path, VAS will no open any 
books.

This Help File Comes with a Demo Set of books. to Install them, place the book files in any directory, 
click the open books option and type in the path of the demo books, vas will open and display the 
books.

To Open A Report:
Simply double click on the row or press <ctrl> V to open the Report.



Report Sheet Tool Bar

The Tool bar is very simple to use. Remember anytime you do something you must be on the selected row in the 
grid, or unfavorable results will happen.

Update Tree of Accounts:
This first Button on the Tool Bar will allow you to Save the Report without exiting the window. It will also
force all the ADD TO Fields to update.

Print:
This Button will allow you to print the report.

Delete a Row:
This option will delete and remove the current row. Make sure that you wish to delete the row because 
you can not undo or recover any deleted rows. 

NOTE: VAS WILL ALLOW YOU TO DELETE ACCOUNTS WITH ACTIVITY ON THEIR LEDGER. IF YOU DELETE 
AN ACCOUNT BY ACCIDENT, YOU CAN RE-ENTER THE INFORMATION WITH THE SAME ACCOUNT 
NUMBER AND THE DATA WILL BE RECOVERED.

Insert A Row:
This Option Will Allow you to insert A row where you have placed the cursor on the Grid. Sometime this
option will seem like it taking a long time, never fear, VAS is resynchronizing the accounts and ADD TO 
fields so everything matches up.

Cut And Paste:
These Two options are not available in this version of VAS, They will be active in the next update or 
upgrade of VAS. If you Need to Cut And Paste Any Thing In Vas Use CTRL X for Cut 
CTRL C for Copy, CTRL V for paste while in any Text Box.

Single And Double Underline:
These Options Allow you to insert a single or Double underline in the active row on the grid. First you 
must put a display column number in the C Field before this option will work.

Goto Row:
This option will allow you to jump to any row that is currently visible on the grid.

Search for Account:
This option will search for any given account number and display where it is located in VAS.

View The Ledger:
This option will allow you to view the ledger for the active row in the grid. Note: You can not view the 
Ledger for the rows that have a T in the T field, these are place holders only for ADD TO displays.

HELP ME!:
Displays this help file.



Report Sheet Menus
File and Data Menus
These options are explained in the Tool Bar help Topic.

View:

Type:
Active Year Only: The Active Year only Display view will update all reports to display the data for the 
active year only.
UP TO ACTIVE YEAR: This menu option will update all reports to display the ledger values    for the 
current year and before.
ACTIVE QUARTER ONLY: This menu option will display in all reports the data for the Active Quarter only. 
UP TO ACTIVE QUARTER: This menu option will display in all reports the data for the Active Quarter and
before.

Select Quarter:
These Menu Options Allows you to select what quarter you wish to make active. When you select one 
of these items, the data in all the reports will update accordingly

Combo
This Menu Option Allows you to select what Year you wish to make active. When you change this items,
the data in all the reports will update accordingly

Note: When a Display is changed in the Reports, it does not affect the view in the Ledgers, the ledger views are 
separate from the Report views.

See Also
                                    Report Sheet Tool Bar
                                    Print Design Window



The Ledger Window

When the ledger for an account is opened you will see something similar to this in the upper portion of the window. 
Below is a description of what all the Items in the Leader Heading.
Number:
This information is the account number that you have given the account.
Description:
This information is the description that you have given the account
Normal Balance:
This is the Normal Balance of the Account.
Number of Items:
This is the number of Entries in the Current view of the Ledger.
Current Quarter:
This is the Active Quarter you have Selected to View in the Ledger
Current Year:
This is the Active Year you have Selected to view in the Ledger.
Reconcile Date:
This is the Date of the last item that has be reconciled.
Reconcile Balance:
This is the amount of all the Reconciled items for the selected quarter and year.
Closing Balance:
This is the amount of all the Entries for the Active Quarter and Year
Balance Forward:
This is the amount of all the Entries before the Active Quarter and Year, Reconciled and non 
Reconciled.
Ledger Entries
To Learn More about Ledger Entries you should also See Business Situations. In The Registered Version of Vas you 
can have up to 2 billion entries in your ledger for each account. The Non Registered Version Will only allow you to 
view 100 Entries at a time, but when you Register Vas and if properly installed you will not lose those entries over 
100. 
NOTE:    By Double clicking on a Row you can create a Complex Transaction.

See Also
Business Situations
Complex Transactions
Ledger Menus
Account Ledger Box



Ledger Menus
The File and Data Menus are pretty much self Explanatory, but you should drop by the Print Header Topic if you 
don't under stand Printer Setups. Under the File menu is a sort option. You can sort your Ledger entries accordingly 
What We are going to concentrate on in this Topic is the View Menu, Below Explains The options under the Menu.

Transaction:
ALL DATES: This menu Option Tells the Ledger that you wish to view the total of all the Transaction 
previous to the Active Quarter and Year. Selecting This item will make your Balance forward hold a total
of all previous entries.

ACTIVE QUARTER ONLY: This menu Option Tells the Ledger that you wish to View the Totals for the 
Active Quarter Only. When you Select this menu item, your balance forward will become a zero (0.00) 
therefore showing you only the totals for that quarter.

STARTING DATE: This menu option will allow you to select a date you wish to start view from. IE: if you 
select today's date, it would only show transaction entries from today's date forward.

Quarter:
This Menu Item allows you to Select which Quarter you wish to make active. When you Select this 
menu item the Entries in your ledger will change to the quarter that you have specified.

Type:
RECONCILED: This menu option will display only the items for the Active Quarter and Year that have be
Reconciled by you. To Reconcile an item in your Ledger, Place an R in the R field.

NON RECONCILED: This menu option will display only the items that have not been Reconciled for the 
Active Quarter and Year.

BOTH: This option Will Display Both Reconciled and Non Reconciled Entries in your Ledger.
------------------------------------------------------------------------------------------------------------------------------------------------
-----
DEBITS: This option will allow you to view Only The Debits for the Active Quarter and Year.

CREDITS: This option will allow you to view Only the Credits for the Active Quarter and Year.

BOTH: This option will allow you to view both Debits and Credits in your ledger.

Select Year:
This Option Will Allow you to Enter the Year you wish to view in the Ledger.

History:
This option Will open another window and break the Years and Quarters down and show you the totals 
for those years.

Audit Trail:
This Option will Show you another window that displays any deleted Ledger entries for the active 
account, it will also display the date deleted and who had deleted it.

See Also
                Notes Window  
                Print Design Window  



Employee Payroll
Situation:
Your Business Pays one of your Employees $5000.00 in Wages.
Accounting Method:
Debit Salaries & Wages Expense                                                      $5000.00
              Credit Federal Withholding Taxes Payable                                $1000.00
              Credit State Withholding Taxes Payable                                        $    250.00
              Credit FICA Taxes Payable                                                                                $    300.00
              Credit Accrued Payroll                                                                                                $3,450.00

Entries to Show Payment to Employee:

Debit Accrued Payroll                                                                                                $3450.00
                  Credit Cash Payroll Account                                                                           $3,450.00
Vas Method:
In Vas You Would have to use a Complex Transaction to Record these Entries. The First Step would be to
open the ledger for the SALARIES & WAGES EXPENSE account. Then follow the Steps for the Creating a 
Complex Transaction. The second part of the entry would be to simply open the ledger for ACCRUED 
PAYROLL and Credit the Payroll account and Enter the Transaction.    What is really Cool about VAS is 
that you can setup The Calculations Functions to automatically Figure out what percentages of the 
Employee's pay should be taken out, For more information on this Function you should click the See 
Also option below. If you are having trouble understanding how to do this you should view some of the 
other Situations until you get a feel of VAS and How it works.

See Also
                                    Complex Transactions Menus



Sales Returns and Allowances
Situation:
A Customer Returns Merchandise because it was Dented, you must Refund him $700.00
Accounting Method:
Debit Sales Returns/ Allowances                $700.00
            Credit *Accounts Receivable                                $700.00

*- if the customer had paid cash for the Merchandise then you would credit CASH IN BANK
VAS Method:
Open the Ledger for Customer's Account Receivable or if the Customer paid Cash you can place this 
transaction in the CASH IN BANK Ledger. Enter the amount    into the amount field as a negative 
number and then in the Account Field enter the account number for Sales Returns/Allowances. If the 
Customer returns more than one thing then you can use a Complex transaction.
NOTE: Sales Returns and Allowances is a Contra Account and should make Retained Earnings go down.



Purchase of Merchandise
Situation:
Your Business Buys Stuff to Sale, costing $3000.00 on Account
Accounting Method:
Debit    Inventory                                                    $3000.00
              Credit Accounts Payable                              $3000.00
Vas Method:
Open the ledger for Accounts Payable if more than one item is on the invoice then a Complex 
Transaction is need. Enter The needed information and put in the account numbers that correspond to 
the inventory items. 



Requirements
To Run Vas on your computer you will need at least:
386SX - 16
2MB of Ram - 4MB is HIGHLY RECOMMENDED.
Any Type of Floppy Drive will do.
At Least 40MB Hard Disk Drive. (That is if you only install Windows and VAS on the computer)
Microsoft Windows 3.1



The Account Referance Box is your interface with other account numbers while in the ledger or Complex Ledger. To 
Activate the Account Referance Box you either Click on the Account Field or press the Tab Key while you are on the 
account field.

When The Account Referance Box is active you can us your mouse to select a Report that you wish to view. Once 
the Report is selected it will give you a description of that report, it will also fill the accounts box with all the 
available account numbers. When you click one of the Account Numbers it will a description of that account in the 
Description box below. Once You have chosen an account number you can press the paste button and the Account 
number will be placed in your ledger or Complex Transaction. If you wish not to paste an account number than you 
can use the exit key to exit the Account Referance Box.



Installation

 Run Setup.exe From the downloaded directory or the disk. Enter the install from path and 
the install to path and press continue. VAS Setup will take care of the rest.

Once the setup program has finished double click on the VAS icon in the Dragon software 
Program Group in Your windows Program manager. Enter your name and Company name. 
Enter the directory where you wish to keep your default books. The sample and Empty books
will be installed under the Application directory as NEW and SAMPLE. After You enter the 
Application Path, The same as the Install to directory, you will be on your way. Follow the 
prompts until you come to the main menu, then you can get started.



Unearned Revenues
Situation:
Your Business receives $500.00 from John Ball for a Repair on his computer before you do the work.
Accounting Method:
Debit Cash In Bank                                                            $500.00
            Credit Unearned Service Revenue                  $500.00

To show Repair of Computer

Debit Unearned Service Revenue                  $500.00
          Credit Service Revenue                                                        $500.00
VAS Method:
Open the Ledger for Cash In Bank, Place the need information, in the amount field place a positive 
number to show Cash going up, in the account field, place the account number for Unearned Service 
Revenue. 
To Show the Repair of the Computer - open the ledger for Unearned Service Revenue    place a negative
number in the amount field to show the account going down and place the account number for Service
Revenue in the account field



Depreciation
Situation:
You Business calculates Depreciation on an Asset that Cost $13000.00 that has a life of 5 years and an 
estimated salvage value of $1000.00
Accounting Method:
Debit Depreciation Expense                                  $200.00
          Credit Accumulated Depreciation                        $200.00

Monthly Depreciation is calculated like this:

M = COST - Estimated Salvage Value
depreciation = M/ Number of months of usefulness    
VAS Method:
Open The Ledger for Depreciation Expense and Enter the needed information into the ledger in the 
account Field enter the account number for Accumulated Depreciation.

Note: Vas Does not update This account for you monthly, you will have to do it every monthly. In Later 
Upgrades, Vas will have this option Available. 



Handeling Supplies
Situation:
Your Business Buys paper clips, Pens, Notepads and other stuff for $500.00
Accounting Method:
Debit Office Supplies                                        $500.00
          Credit Cash In Bank                                                  $500.00

To Show The usage of $200.00 of the Supplies at the End of the month:

Debit Office Supplies Expense                $300.00
          Credit Office Supplies                                                  $300.00
VAS Method:
Open the Ledger for Office Supplies, enter the information, if you would like to use a complex 
transaction you can. Enter the amount as a positive number to show the Asset Increasing. In the 
Account Field enter the account number for Cash in Bank.

To Show Usage At the End of the Month:

Open the ledger for Office Supplies Expense and the amount of supplies used in the amount field, you 
can use a complex transaction for this also, in the Account Field enter the account number for Office 
Supplies to show the Asset decreasing.



Prepaid Rent
Situation:
Your business pays for Rent In Advance, costing $800.00
Accounting Method:
Debit Prepaid Rent                                      $800.00
          Credit Cash In Bank                                          $800.00

To Show Monthly Expense.

Debit Rent Expense                                  $200.00
          Credit Prepaid Rent                                          $200.00

Note: When you pay your Rent in Advance, an Asset is Created. As time Goes by, the asset is used up 
and then becomes an Expense.                                              
VAS Method:
Open the Ledger for Prepaid Rent, Enter the need information, in the Amount field Enter a positive 
number to show increase of an Asset, Enter the Account number for CASH IN BANK. This will show the 
Payment of the Rent.

To Show Monthly Expense of the Rent, Open the Ledger for the Rent Expense and enter the information
for that Month. Enter the Amount as a positive number, and place the account number for the PREPAID
RENT in the Account Field. This will decrease your Prepaid rent Asset as time goes by.



Prepaid Insurance
Situation:
Your Business pays its Insurance in Advance, which Costs $400.00
Accounting Method:
Debit Prepaid Insurance                                                      $400.00
          Credit Cash In Bank                                                                        $400.00

Entry to show Quartly Expense

Debit Insurance Expense                                                  $100.00
          Credit Prepaid Insurance                                                          $100.00

Note: When you pay your Insurance in Advance, an Asset is Created. As time Goes by, the asset is 
used up and then becomes an Expense.        
VAS Method:
Open the Ledger for Prepaid Insurance, Enter the need information, in the Amount field Enter a positive
number to show increase of an Asset, Enter the Account number for CASH IN BANK. This will show the 
Payment of the Insurance.

To Show Quartly Expense of the Insurance, Open the Ledger for the Insurance Expense and enter the 
information for that Quarter. Enter the Amount as a positive number, and place the account number for
the PREPAID INSURANCE in the Account Field. This will decrease your Prepaid Insurance Asset    as time 
goes by.



Setting Up New Accounts
Adding New Accounts is very Easy. Simply place the cursor on the Report Sheet Where you wish to display the new 
account. Select Insert from the Data Menu. VAS Will insert a new blank line. By placing in the need information you 
will have created a new account. To use the new account, just simply double click on its row.

See also
                Report Sheet Setup  



Report Sheet Setup
This section will describe the Report Sheet Fields and how they work. Notice the sample sheet below. This is a 
sample Accounts Receivable Report Sheet. Report Sheets allow you to have 32,000 Rows per report, but you may 
only display 499 of them at one time. To Display the next 499 rows of information, move to the last row and press 
the down arrow key. This will allow you to display The next 499 rows of information. It is unlikely that you will use 
32,000 rows of information on a report sheet, but it is available if you need it. If you wish you can move your mouse
to the upper gray area and you mouse pointer will turn into arrows. By holding down the left mouse button you can 
change the size of the fields. To Edit any fields in the Grid you can simply press the TAB key or press <CTRL> E.

Description Field:
This Field allows you to enter the description of the account. You can also place just text in the field to 
describe sections of your report or you could leave them blank. If you View the Sample Books that 
come with VAS you will see more clearly how the description fields are used. Note: You are limited to 
50 characters in this field.

1,2&3 Fields:
If you have all rights access you may edit these fields, but it is not recommended, however if you ever 
have the need to 
edit these files you will have the capability. These fields are for displaying the total of the ledger.

C Field:
This filed allows you to specify which field -(1, 2 or 3)- to display data in. notice above that the number 
in the C field corresponds with the field that the data is displayed in. The only legal entries for this field
is 1, 2 or 3.

B Field:
This Field serves two purposes. There are four Legal entries allowed in this field- D, C, U, or K. The 
primary Purpose of this field is to describe the normal balance of the account, D would be a debit 
account and C would be a Credit account. In A case where you would like an underline in the 
corresponding field you could place a U for a single line or a K for a double Underline. If you place a U 
or K in this field manually, no underline will be displayed until you exit the screen and come back to it. 
To View the Underlines while you are editing it you should use the menu options or the toolbar buttons 
to place the underlines in the Report Sheet.

Account Number Field:
This is where you give your account a number or a name. After Filling in the information in all the fields
before the Account number, you will be allowed to enter a number or name in this field. Once this has 
been done, you will be able to double click on this row and view the ledger for the account. 

Add To Fields:
This Field will allow you to add the total from the account to another Row. Vas will take the numbers 
from the account and add to the corresponding display field with the same account number. The 
Account number that you specify to add to does not have to be on the same report, it can be on any 
report.    As you notice above in most of the Add to fields there is the name TAR, if you look through the
rows, you will notice an account number with TAR in it. This Row on the Report sheet is not really an 



accounts, it is just a place holders that displays the total of all the accounts that have it's account 
number in the Add To Field. , therefore you can not view a ledger on this row. In the Sample above, all 
of the accounts Receivable are being added to the TAR Account, therefore showing the total of all the 
accounts. You Should also note that if you have just created a report sheet and are starting to enter the
ADD TO information, the Underlines you have created will disappear. To remedy this, it is recommend 
that you save the Report before you Enter the ADD TO Information, There is two ways you can do this, 
you can exit the window all together or you can use the update tree of accounts function built into the 
menus and toolbar.    

NOTE: THAT IF THE NORMAL BALANCES ARE THE SAME, THE NUMBERS WILL ADD TOGETHER, IF THEY 
ARE OPPOSITES, THEY WILL SUBTRACT.

WARNING: IF YOU PLACE THE SAME ACCOUNT NUMBER THAT IS IN YOUR ACCOUNT NUMBER FIELD IN 
THE ADD TO FIELD ON THE SAME ROW, THE COMPUTER WILL LOCK UP AND GO INTO A CONTINUOUS 
LOOP. 

T Field:
This field is here to show that the corresponding row is a add to account. Therefore, if there is a T in 
this field you can not view the ledger because this is just a place holder to display totals and is not 
really account.

See Also
                Report Sheet Tool Bar  
                Report Sheet Menus  



Complex Transactions

Complex Transmissions could be an invoice in accounts receivable, an invoice of items that you have bought for you
office, or Merchandise that you have purchased for inventory. Complex Transactions allow you to have many debits   
with only one credit, or vise versa. Normal Accounting says you must have a debit    for each credit or many credits 
for one debit. But you can have one Debit for many credits if you wish as long as the one debit is the total of all the 
credits. 
To Enter A complex Transaction in VAS you must first be in the Ledger of the account you wish to enter a complex 
transaction The example below shows the first step to entering a complex transaction.
The Example we will be using is an invoice for John Ball on account. Enter the Date in the date field. You can enter 
the invoice number in the Referance number field and in the Description field you can place anything you like to 
discrete the transaction. Once you have done this, double click the row to display the Complex Transaction Screen. 

On The Top Portion of the complex Transaction Screen you will see the information that you have just entered on the
previous screen. In the empty spaces below is where you would actually enter the transactions. The Example below 
Demonstrates this.

In the Quanity Field is where you will place the number of items that John Ball is buying. In the description field is 
where you would put the description of the item that John is buying.    In the amount field you would enter the 
amount of each computer Diskette. The Total Field will update automatically displaying the total    so far. When you 
reach the account Field, you can double click on the field or press tab to select the account number that you wish to
debit or credit. Once you have finished filling in the information that is need you can close the windows and Vas will 
automatically update everything
instantly. You will notice an    astrik in the account field when you return to the Ledger window, This signifies that the
entry is a complex transaction. If you wish you can double click on that row again and view the transaction, but you 
will not be able to edit it.      

See Also
                Complex Transaction Menus  
                Account Referance  



PRINT DESIGN WINDOW

The Report Design is a WYSIWYG(What You See Is What You Get) system similar to Crystal Report for 
Microsoft Access. To design a report for VAS you place tax boxes, lines, and datafields on the screen 
where you would like them to be printed out. You can also change the fontsize and color of the text 
and data fields. VAS's Print Design Window will support color printers.
Adding, Moving, and Sizing Items
To Add an item to the page you can select Add item from the approiate menu. Once you have the Item 
on the page you can move it to the disired location by dragging the item with the mouse. Once you 
have the item on the page you can have the approiate menu item popup by clicking on the item with 
the right mouse button. To size a text box or a line, activate the disired item, a small black box will 
appear in the lower right hand corner of the item, move the mouse over the black box until the mouse 
cursor turns into a resize icon, press down the left mouse button and resize the item to the desired 
size. 
Header, Detail, and Footer
the blue horizontal and vertical lines on the page are the margins, however you are not bound to only 
placing items within these line, if you need to place an item outside of these lines you may do so. The 
Horizontal Blue lines represent the page header and footer, you can not move detail items into    these 
areas, you may move header items into the detail area but they will not print. The red horizontal lines 
represent the detail area of the report, this is where the contents of your ledgers, reports and 
complex transactions will be printed. the further the topmost field or text description is from the top 
red line is how far apart each detail line will print. You will only have to place one detail line of fields in
the detail area, you should examine and print the samples supplied with the software to determine 
what is the best setup of for your needs. For more information on how to resize the margins, header 
and footer size you should see Page Setup. 
Opening A Report
If you have not created a report for the report, ledger, or complex transaction, when you load the print
design window, default.XXX is copied from the application directory to your book directory with the 
report, ledger, or complex transaction's name and the appropriate file extensions. A list of the file 
extensions is given below:
*.LRP ..........................................Leader Report File
*.RRP..........................................Report Report File
*.CRP..........................................Complex Transaction Report File

You may change the default.XXX in your application Directory to fit your needs. You may also have as 



many reports as you wish for each account, when you run the print design window, select the file 
menu and then open, and then select the custom report design you wish to print.
Adding Graphics To Your Report
If you wish, you may also print a custom logo or graphic in your Report Header. To Add a logo, select 
the Add Graphics Menu option from the file menu, a file dialog box will appear asking you what file to 
load. You will not beable to resize the graphic once it is loaded into the Print Design Window, so it is 
best to have it cut down to the size you want before loading the graphic into the Print Design Window.
You may only place Graphics in the header of your report. If you wish to remove the graphic you can 
select remove graphic from the file menu. 
Note that graphics option will not work correctly on PostScript printers.
Instead of the picture control printing, two blank sheets are ejected from the printer when using a 
printer configured to use the PostScript printer driver. For the options to work correctly, the printer 
must use a standard non-PostScript laser printer configuration (such as PCL/HP.)
Batch Print
The Batch Print Menu Option will only be enabled while you are in the Print Design Window for a 
Ledger. This option will allow you to select the accounts you wish to print using the save options for 
that account. If at the end of the month you wish to print 30 to 40 ledgers and do not wish to enter 
each account to print the ledgers, then this option is for you.
Daily Print
This File menu Option will allow you to print all entries on a given day in all the active accounts in the 
loaded set of books... If you have a need to check the work that was entered on a given day, then you 
may use this option to do so. You may only use this menu option from the Ledger print design window.
Ledger Print Setup
This menu option under the menu is supplied so you can control what is sent to the printer in you 
current ledger, here is an over view of the Menu Options...

ALL...............Will Print All Items in the Current Ledger Default
Current Row...Will only print the Current Row on the ledger(good For checks)
Range............Will only print a range of rows that you specify
GRID
The Grid option will display a grid on the page to help maneuver and place fields, text boxes and lines.



Complex Transaction Menus
The File Menu

The Data Menu
The only thing that needs discussed on the Data menu is ADD SALES TAX and CALCULATIONS. Each 
Account can have it's own Sales Tax amount. By selecting this menu option, VAS will insert the Sales 
Tax Calculation into the Current row on the Grid. REMEMBER: if you have never    setup the Sales Taxes 
in the Setup Menu the line will remain empty.

CALCULATIONS are programmed by the User to quickly enter information into the grid. You can set up 
these Calculations in the Setup Menu.

The Setup Menu
STATE SALES TAX: This option will load an input box for you to enter the Sales Tax Rate for the current 
account. Note that every account can have its own sales tax rate, so if you create a new account you 
may need to set this option up. When the Input box loads you will see .06 in the text field. this is the 
default Tax Rate of 6% if you need to change the tax rate then enter the tax rate you wish to have and 
press enter. Once you leave the Input box the Sales Tax is installed and you will not need to use this 
option again for the active account unless you need to change it.

CALCULATIONS: This option will allow you to Setup up Quick Calculations, If you select one of the 
letters in the menu then you can begin setting up that calculation for the active account. A window 
similar to the one below will appear. Type in the information you wish to associate with the Calculation.

The Name of the Calculation will appear in the menu when you exit the window. The name will appear 
in the menu each time you create a Complex transaction for the active account. Remember each 
account can have it's own set of Calculations, so each time you setup a calculation it is for the Active 
account only.    In The Description field you will place the text you wish to show up in the Complex 
Transaction Description field when the Calculation is activated.

This option is good for Good Customer Discounts or any other reason that you wish to use it for. if you 
place a negative number in the text box between X and = it will subtract that calculation from the total
on the Complex Transaction. You have the option to divide the total by a number or to Multiply the total
by a number, it is up to you which one to select. Once you have finished you can press the    Save 
button and the calculation is saved for the active account. if you wish to use it then under the data 
menu you will see the newly setup Calculation name in the Calculations menu. If you wish to change 
the Calculation later you can select the calculation name from the setup menu and the setup windows 
will reappear.

REMEMBER: Each account has it's own Calculation Setup, what you setup in one account will not effect 
any other accounts.



Complex Transaction File Menu
Notes:
This menu option will load the notes editor and allow you to edit the notes for the account. 
Print Design
These menu Options will allow you to Edit and change the Print Header, footer, and body for the 
complex Transaction.
Exit:
This Menu Option will allow you to save and exit the Complex transactions window.
About:
This Menu Option will display the about window that is displayed when VAS is loaded.

See also
                        Print Design Window
                        Notes Window



Notes Window
The Notes window allows you to enter information on each account as you see fit. Once you leave the window it will
save. When you open the windows again it will display the notes that you have entered. Each Account has its own 
Notes Option, Meaning that Each account can have its own Set of Notes.



Security System

The Security System allows you to control who can enter into the accounting system and what they can do once 
they are in. The information is encrypted and stored on the sub directory where the books exist. Each Set of books 
can have it's own list of users. To Add A New Person, press the add button and enter the information disired for that 
user. Click the delete button to delete a user that is highlighted. Click the Edit button to edit an existing user. 
You Can restrict the User to certain reports in the Program. A list of all your reports in the books will be displayed in 
the Available Reports List Box, double click the reports you wish the user to have access to. To Remove The access 
rights to a given report    Double Click on the name in the Report Rights Box, this will cause the report to be 
removed and added back to the Available    reports box.

NOTE: 
When You Create A new Set of books or first install the software, Vas will display this window. If you do not 

wish to use the security system press the EXIT button and the security system will be deactivated. The password 
Window will popup each time you open VAS or open a new set of books, By Press the OK button or Pressing Enter, 
Full Access will be granted. 

When You Register This Software You will be given the option to have a Registration password sent to you via E-MAil 
on America online. When you receive the password enter it into the password box and Registered Access will be 
granted, meaning you will be able to view more than a hundred transactions for each account. You will still receive a
registered version of the software in the mail that has an encoded serial number.



Questions And Answers.

I'm An Accountant and would like my Customers to have VAS.

You Can not Give them a copy of your Software, Your Customer must purchase the software, or you 
contact me and I will give you a very large resaler discount. The First Copy you Buy of VAS is $65.00 
Each Copy After that is only $30.00. If you buy over 30 Copies of VAS you will get them for $15.00 a 
copy

I'm a programmer and I was wondering if I could purchase the Source Code To VAS So I could make my 
own modifications.

Yes, I will sell the Source Code for VAS, but it is not Cheap. To Get the Source Code For VAS will Cost 
$200.00. Remember That this Software is Copyrighted and you will not beable to Release the Software
as your own.

I would like to Sell or Upload Custom Books for other people to use.

If you wish you can upload custom books for other people to use, you can also charge as much as you 
want to setup those books. Remember that the person That uses the books must Purchase a copy of 
VAS, You can not give them your copy of VAS.

I can't seem to get my lines the right distance a part when I print using the print design window

The distance from the Top of the read line and the top of the first text, line, or field in your detail area 
is how far apart your lines will print.

I've got VAS Installed but I do not know the password

You do not need a password when you first install VAS, you may press the OK button and you will be 
allowed access to the Accounting system.

How do I enter a description of for a Complex Transaction

You Must enter the description in the correct field before you enter the data for the complex 
transaction.

How can I get Support for VAS

You may Get Support from Gaming 101 BBS in Fairmont WV where we will answer any questions you 
may have...The number to Gaming 101 is
(304)363-2252



Dragon Software is continuously Updating it's software or adding options for Registered users. 
Registered Users and Non Registered user alike can get SUPPORT at NO CHARGE.    If you would 
like to download the latest version, make suggestions, Report Bugs, or just    simply Make a 
comment then you can call our Official Support BBS. There is no registration hassle, Type your 
name, address and password once you have reached the main menu type J <Enter> and then A 
you will have immediate access to the DRAGON SOFTWARE SUPPORT Message Base. 



Page Setup

The Page Setup window will allow you to adjust the size of your page and margins in the print design 
window. If you have a need to print labels or checks you may wish to change the way the page is 
displayed in the print design window. This option will not change the size of the printer itself, you 
must configure your custom paper sizes for your printer in the windows control panel and then select 
custom paper size in the printer setup in VAS when you wish to use a non standard size of paper.



VBRUN300.DLL
The Visual Basic Runtime library is not supplied with this program, however you may find it 
on almost all BBS's and Commerical Online Servies. Before this Software will run Correctly, 
you will need to install this file in your windows system directory or the application directory.



Hot Keys
The hot key menu is provide to speed up transaction or report entries, to use this option, 
select the menu option "SETUP HOTKEY" You will be prompted to enter the account you wish 
to make a hot key, from then on you can use the corresponding Hot key to enter that 
account number into the row you are currently working on.






